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Black	and	white	photography	is	never	old	fashion,	actually,	it’s	classic	and	elegant.	A	black	and	white	image	is	also	great	for	using	as	a	poster	background.	You	can	simply	desaturate	the	photo	or	edit	it	from	grayscale	color	mode.	Making	an	image	black	and	white	is	such	a	simple	step	and	there	is	a	lot	you	can	do	to	manipulate	it.	In	this	tutorial,
you’ll	learn	three	quick	ways	to	make	a	color	photo	black	and	white	in	Photoshop.		Note:	All	screenshots	are	taken	from	Adobe	Photoshop	CC	Mac	version.	Windows	or	other	versions	can	look	different.	Method	1:	Adjustments	Panel	Step	1:	Open	your	image	in	Photoshop.		Step	2:	Find	the	Adjustments	panel	on	the	right	side	of	your	canvas,	usually,	it’s
next	to	the	Properties	panel.		Step	3:	Click	on	the	Black	&	White	icon	to	add	an	adjustment	layer.		Now	your	photo	should	be	black	and	white.		Is	it	too	dark?	Does	a	certain	area	need	more	light?	You	can	move	the	slider	and	explore	the	specific	colors	to	get	the	perfect	black	and	white	effect	you	want.		Or	you	can	always	go	back	to	the	Adjustments
panel	and	choose	another	adjustment	to	edit	your	image.	For	example,	I	did	a	couple	of	adjustments	to	brighten	up	the	photo.	Method	2:	Desaturate	This	is	a	quick	method	that	you	can	finish	in	one	step.	After	opening	your	image	in	Photoshop.	Simply	use	the	keyboard	shortcut	Command	+	Shift	+	U	to	desaturate	your	image.	If	you	want	to	adjust	the
lightness,	follow	the	steps	below:		Step	1:	Go	to	the	overhead	menu	Image	>	Adjustments	>	Hue/Saturation.	Step	2:	Move	the	Saturation	slider	to	the	end	of	the	left	side	(-100)	to	desaturate	the	photo	and	you	can	adjust	the	lightness	accordingly.	Tips:	Check	the	Preview	box	to	see	the	changes	as	you	adjust.		Step	3:	Click	OK	once	you’re	satisfied	with
the	look.	If	not,	you	can	always	add	an	adjustment	layer	from	the	Adjustments	panel.	Method	3:	Color	Mode		Another	way	to	make	a	color	image	black	and	white	is	by	changing	the	color	mode	of	your	Photoshop	document	by	following	the	steps	below.		Step	1:	Once	you	have	your	photo	opened,	go	to	the	overhead	menu	Image	>	Mode	>	Grayscale.	
Step	2:	Click	Discard	on	the	pop-up	window.		Same	as	with	the	other	methods,	you	can	add	an	adjustment	layer	and	manipulate	the	photo.		Conclusion	There	are	certainly	more	than	three	ways	to	convert	a	color	photo	into	black	and	white,	I’ve	just	listed	a	few	that	are	most	commonly	used	and	easy	to	apply.	No	matter	which	method	you	use,	you	can
always	add	an	adjustment	layer	to	manipulate	the	image.		Hope	you	find	this	tutorial	helpful.	About	June	Photoshop	makes	it	easy	to	convert	your	color	photos	to	black	&	white,	but	typically	you	will	also	need	to	make	some	other	adjustments	in	order	to	get	your	black	&	whites	just	how	you	want	them.	In	this	tutorial	we’ll	show	how	you	can	create	a
black	&	white	conversion	that	has	sort	of	a	vintage	or	film-inspired	effect.	Here	is	the	before	version	of	the	photo	that	we’ll	be	working	with	for	the	tutorial:	And	here	is	how	it	will	look	after	the	effect:	The	first	step	is	to	add	a	gradient	map	adjustment	layer,	which	will	handle	the	black	&	white	conversion.	Select	the	black	to	white	gradient	and	leave
the	blend	mode	set	to	“normal”	and	leave	the	opacity	at	100%.	Next,	add	a	curves	adjustment	layer	and	create	a	tone	curve	like	the	one	shown	below,	which	mostly	impacts	the	ends	of	the	tone	curve	for	the	light	and	dark	areas	of	the	photo.	Now	we	want	to	add	another	curves	adjustment	layer	and	apply	the	curve	shown	below.	Lift	up	the	middle
area	of	the	curve,	which	will	lighten	the	mid	tones	of	the	photo	to	achieve	the	faded	look.	The	next	step	is	to	add	a	levels	adjustment	layer	and	edit	the	settings	as	shown	below.	You’ll	be	changing	the	midtone	input	to	0.90	and	the	highlight	output	to	245.	This	will	slightly	darken	the	midtones	and	highlights.	Next,	add	a	brightness/contrast	adjustment
layer.	Add	some	brightness	by	setting	it	to	15	and	reduce	the	contrast	to	-35.	Now	our	photo	looks	like	this:	Are	you	wondering	how	to	make	images	black	and	white	in	Photoshop?	Black	and	white	photography	is	as	popular	as	ever,	and	with	digital	software	like	Adobe	Photoshop,	it's	never	been	easier	to	convert	your	digital	images.	What	You'll	Learn
In	this	article	we'll	run	through	some	of	the	most	popular	black	and	white	conversion	methods,	outlining	the	pros	and	cons	of	each.	Instructions	are	provided	for	Photoshop	CS	and,	if	the	technique's	available,	Photoshop	Elements.	The	techniques	we	cover:	How	to	convert	images	to	greyscale	(destructive)	How	to	use	the	Hue/Saturation	Tool	(non-
destructive)	How	to	use	the	Lab	Color	Method	(destructive)	How	to	use	the	Gradient	Map	in	Photoshop	to	make	an	image	black	and	white	(non-destructive)	How	to	make	an	image	black	and	white	with	the	Photoshop	Channel	Mixer	(non-destructive)	How	to	use	the	Twin	Hue/Saturation	Method	(non-destructive)	How	to	use	the	Black	and	White
Adjustment	Layer	Method	(non-destructive)	How	to	use	the	Camera	Raw	adjustment	layer	(Smart	Objects,	non-destructive)	How	to	use	Look-Up	Tables	(non-destructive)	Don't	want	to	read	through	every	technique	for	making	an	image	black	and	white	in	Photoshop?	We	recommend	the	last	two	methods	for	most	people:	using	the	Camera	Raw	filter
and	LUTs.	Using	Photoshop	to	convert	an	image	to	black	and	white	digitally	has	a	number	of	advantages.	By	starting	with	a	colour	photo	and	converting	it	to	black	and	white	in	Photoshop,	you	have	complete	control	over	the	conversion.	For	the	best	possible	conversion,	start	by	shooting	in	RAW.	Then,	in	your	RAW	conversion	software,	output	the
photo	as	a	16-bit	Tiff	file.	16-bit	files	have	a	lot	more	information	to	work	with	than	8-bit	files,	which	makes	for	a	better	conversion	with	smoother	tonal	gradation.	Most	digital	SLRs	(and	some	compacts)	have	a	black	and	white	mode.	The	camera	is	making	the	conversion	for	you,	and	the	results	are	usually	poor,	giving	flat,	washed-out	photos.	It's
usually	best	to	avoid	this	mode	and	use	the	following	techniques	instead.	Black	and	White	Conversions	Photoshop	and	Photoshop	Elements	offer	both	destructive	and	non-destructive	black	and	white	conversion	techniques.	Destructive	methods	are	ones	that	can't	be	readjusted	afterwards.	Once	you've	made	the	conversion,	the	only	way	to	change	it	is
to	undo	the	conversion	and	start	again.	Non-destructive	methods	use	Photoshop's	adjustment	layers.	The	changes	that	you	make	to	your	photo	are	stored	in	a	layer,	and	the	original	photo	remains	unchanged	underneath.	Then,	when	you're	done,	you	flatten	the	image,	and	it's	at	this	stage	that	Photoshop	makes	all	the	changes	to	the	photo	permanent.
You	can	edit	the	conversion	at	any	time	before	flattening	the	image	by	clicking	on	the	Adjustment	Layer	icon.	Non-destructive	photo	editing	is	always	better	than	destructive	photo	editing!	A	non-destructive	adjustment	layer	1.	How	to	Convert	an	Image	to	Greyscale	(Destructive)	The	simplest	black	and	white	Photoshop	conversion	method,	converting
to	grayscale,	discards	all	the	colour	information	in	the	photo.	Image	>	Mode	>	Grayscale.	Click	Discard.	The	method	for	making	an	image	black	and	white	is	the	same	for	both	Photoshop	and	Elements.	Pros:	Quick	and	easy.	Cons:	You	have	no	control	over	the	conversion.	2.	How	to	Use	the	Hue/Saturation	Tool	(Non-Destructive)	This	method	gives	the
same	result	as	converting	to	greyscale	and	adding	a	black	and	white	adjustment	layer.	The	advantage	is	that	it's	available	as	an	adjustment	layer	and	can	be	used	as	part	of	a	non-destructive	editing	process.	It's	a	simple	way	to	make	your	image	black	and	white	in	Photoshop.	Photoshop	CS	and	Photoshop	Elements:	Layer	>	New	Adjustment	Layer	>
Hue/Saturation.	Click	OK.	Move	the	Saturation	slider	all	the	way	to	the	left	(-100)	and	press	OK.	Pros:	Quick	and	easy	and	can	be	applied	as	an	adjustment	layer	in	both	Photoshop	and	Elements.	Cons:	You	have	no	control	over	the	conversion.	Reduce	the	Saturation	to	0	3.	How	to	Use	the	Lab	Color	Method	(Destructive)	This	technique	converts	your
photo	from	RGB	colour	mode	to	Lab	colour	mode.	Lab	mode	records	the	brightness	and	colour	values	separately,	meaning	in	Lab	you	can	discard	the	colour	information	to	leave	a	black	and	white	image.	It's	useful	for	making	an	image	black	and	white,	but	it's	not	available	in	Photoshop	Elements.	Image	>	Mode	>	Lab	Color.	Go	to	the	Channels
window	if	it's	already	open	(if	not	go	to	Window	>	Channel)	and	select	the	Lightness	channel.	Image	>	Mode	>	Grayscale.	Click	OK.	Pros:	Gives	a	black	and	white	conversion	that	is,	theoretically,	more	mathematically	accurate.	Whether	it's	a	pleasing	conversion	depends	on	the	picture.	Cons:	Destructive	editing	process	that	doesn't	give	you	much
control.	4.	How	to	Use	the	Gradient	Map	(Non-Destructive)	The	Gradient	Map	tool	maps	a	black	and	white	gradient	to	the	brightness	values	of	your	photo.	Dark	areas	become	black	or	dark	grey,	and	highlights	become	white	or	light	grey.	Press	D	to	reset	the	foreground	and	background	colours	to	black	and	white.	Layer	>	New	Adjustment	Layer	>
Gradient	Map.	Click	OK.	Gradient	Map	technique	Pros:	Quick	and	easy	non-destructive	black	and	white	conversion.	Cons:	No	control	over	the	conversion.	5.	How	to	Use	the	Channel	Mixer	(Non-Destructive)	The	Channel	Mixer	is	the	first	black	and	white	conversion	tool	listed	here	that	truly	begins	to	use	the	full	potential	of	the	information	contained
in	the	colour	photo.	Colour	photos	have	three	colour	channels:	red,	green,	and	blue.	These	primary	colours	combine	to	make	the	millions	of	colours	in	your	photo.	The	Channel	Mixer	conversion	method	lets	you	adjust	the	ratios	between	the	red,	green,	and	blue	channels.	Lightening	the	value	of	a	channel	with	the	channel	mixer	lightens	colours	close
to	it	on	the	colour	wheel	and	darkens	the	colours	that	are	opposite	it.	Increase	the	value	of	the	red	channel,	for	instance,	and	you'll	make	the	red	tones	in	your	photo	lighter	and	the	blue	ones	darker.	This	has	the	effect	of	lightening	skin	tones	and	darkening	blue	skies.	Channel	Mixer	is	the	digital	equivalent	of	black	and	white	photographers	using
colour	filters.	Setting	the	brightness	of	the	red	channel	to	100%	gives	the	same	effect	as	using	a	red	filter	on	the	lens	with	black	and	white	film.	It's	not	available	in	Photoshop	Elements.	Photoshop	CS:	Layer	>	New	Adjustment	Layer	>	Channel	Mixer.	Tick	the	Monochrome	box.	Move	the	Red,	Green,	and	Blue	sliders	to	the	left	and	right	to	lighten	and
darken	different	tones	in	the	photo.	The	total	of	the	three	sliders	should	be	100%	at	all	times.	Click	OK	when	you're	done.	Channel	Mixer	method	Pros:	Gives	you	a	high	degree	of	control	over	the	black	and	white	conversion.	Cons:	Not	as	flexible	as	the	next	two	techniques.	Not	available	in	Photoshop	Elements.	6.	How	to	Use	the	Twin	Hue/Saturation
Method	(Non-Destructive)	This	technique	uses	two	Hue/Saturation	Adjustment	Layers	to	make	photos	black	and	white	in	Photoshop.	The	top	layer	is	a	straight	monochrome	conversion.	The	bottom	layer	changes	the	colours	of	the	original	photo,	which	in	turn	changes	the	tones	in	the	black	and	white	conversion.	It	gives	you	a	fine	degree	of	control.
Photoshop	CS	and	Photoshop	Elements:	Layer	>	New	Adjustment	Layer	>	Hue/Saturation	and	click	OK.	Move	the	Saturation	slider	all	the	way	to	the	left	(-100)	and	click	OK.	Activate	the	background	by	clicking	on	it.	Layer	>	New	Adjustment	Layer	>	Hue/Saturation	and	click	OK.	Click	OK.	Change	the	blending	mode	of	the	bottom	Hue/Saturation
layer	to	Color.	Double-click	the	bottom	Hue/Saturation	layer's	icon.	Move	the	Hue	slider	left	or	right,	and	watch	the	tones	change!	You	can	also	experiment	with	the	Saturation	and	Lightness	sliders.	Click	OK	when	you're	done.	Twin	hue/saturation	method	Pros:	Extremely	fine	degree	of	control	over	the	monochrome	conversion.	Cons:	None,	but	less
control	than	some	other	methods.	7.	How	to	Use	the	Black	and	White	Adjustment	Layer	Method	(Non-Destructive)	Available	in	Photoshop	CS3	onward,	the	Black	and	White	Adjustment	Layer	gives	you	all	the	control	of	the	channel	mixer	and	twin	hue/saturation	techniques	via	six	colour	sliders.	But	the	most	exciting	feature	is	its	Targeted	Adjustment
Tool.	With	this	tool,	you	can	adjust	tones	in	your	photo	to	make	them	lighter	or	darker.	It's	an	intuitive	and	precise	Photoshop	technique	for	converting	images	to	black	and	white.	Layer	>	New	Adjustment	Layer	>	Black	and	White.	Click	OK.	The	Black	and	White	toolbox	appears.	Move	the	six	colour	sliders	right	or	left	to	brighten	or	darken	the
respective	tones	in	the	photo.	You	can	also	choose	from	the	presets	in	the	dropdown	menu	at	the	top.	Click	OK	when	you're	done.	Pros:	The	most	flexible	black	and	white	conversion	method	available.	Cons:	Only	available	in	Photoshop	CS3	and	up.	Learn	more	about	Photoshop	and	Photoshop	Elements.	8.	How	to	Use	a	Camera	Raw	Adjustment	Layer
(Non-Destructive)	Here's	how:	Adobe	Camera	Raw	has	several	ways	to	convert	to	black	and	white,	and	you	might	already	be	comfortable	with	them.	Why	not	use	the	same	tools	in	Photoshop,	too?	Select	the	layer	(or	layers)	in	Photoshop	to	which	you	want	to	apply	the	black	and	white	filter.	Right-click	on	the	layer	name	and	choose	Convert	to	Smart
Object	from	the	context	menu.	This	conversion	will	turn	your	Photoshop	layer	into	a	Smart	Object	and	allow	you	to	readjust	the	black	and	white	filter	settings	later.	Click	on	the	Filter	menu	again	and	choose	Camera	Raw	Filter.	This	action	will	bring	up	the	Camera	Raw	interface.	9.	How	to	Apply	a	Look-Up	Table	(Non-Destructive)	Here's	a	twist	on	the
Camera	Raw	method	that	uses	presets,	or	Look-Up	Tables,	to	make	the	process	quick	and	instantly	repeatable.		Install	the	LUTs	as	we	cover	in	our	tutorial.	If	you	don't	have	any,	check	out	the	selection	below.	Your	profiles	should	be	visible	under	Browse	Profiles.	Hover	over	each	thumbnail	to	see	a	preview,	and	select	one.	Use	the	slider	to	adjust	the
strength	of	the	effect.	Your	other	sliders	are	still	at	0.	Make	other	edits	based	on	your	chosen	colour	profile,	including	further	changes	to	the	colours	in	the	Colour	Mixer.	5+	Cool	Black	and	White	LUTs	and	Actions	From	Envato	Elements	The	above	techniques	work	when	using	Photoshop	to	convert	your	photos	to	black	and	white.	If	you	want	a
quicker	way	to	get	these	results,	then	check	out	these	black	and	white	add-ons	from	Envato	Elements:	1.	Black	and	White	Action	Kit	(ATN)	If	you’re	looking	for	some	great	Photoshop	actions	to	make	an	image	black	and	white	for	you,	then	there's	plenty	of	choice	over	at	Envato	Elements	where	you	can	download	unlimited	resources	for	a	monthly
subscription.	You	could	start	with	this	set	of	31	Professional	Black	&	White	Photoshop	Actions,	which	gives	you	a	wide	range	of	options	for	creating	different	black	and	white	effects	depending	on	the	look	you're	going	for.	2.	50	Nostalgia	Black	and	White	LUTs	Pack	(LRTEMPLATE)	If	you	like	a	classic	look,	try	out	this	bundle.	It	features	50	unique
Photoshop	black	and	white	LUTs	with	a	nostalgic	style.	This	cinematic	LUT	pack	can	help	you	transform	your	photos	in	a	matter	of	clicks.	3.	50	Black	and	White	Wedding	LUTs	Pack	(LRTEMPLATE)	Are	you	editing	photos	from	your	big	day?	Then	try	out	this	LUT	download.	It	was	created	with	weddings	in	mind	and	makes	it	easy	to	create	black	and
white	images	in	Photoshop.	Use	it	to	add	a	touch	of	elegance	to	shots	of	the	happy	couple.	4.	50	Black	and	White	Mystery	LUTs	Pack	(LRTEMPLATE)	For	a	bit	of	mystery,	try	out	this	cool	black	and	white	LUTs	pack.	The	Photoshop	effect	is	easy	to	apply	and	works	for	both	Mac	and	Windows	devices.	5.	20	Black&White	LUTs	(Look	Up	Tables)
(LRTEMPLATE)	This	bundle	of	20	LUTs	takes	a	unique	approach	to	colour	correction.	It	applies	the	black	and	white	effect,	but	also	comes	with	options	that	allow	a	little	colour	to	seep	through.	Try	it	out	in	Photoshop	to	make	captivating	black	and	white	images.	6.	10	Black	and	White	Lightroom	Presets	(LRTEMPLATE)	We	round	out	our	list	with	these
ten	Lightroom	presets.	The	results	of	the	colour	correction	make	your	photos	look	as	if	they	were	shot	in	black	and	white	originally,	without	the	use	of	Photoshop.		Speaking	of	presets,	you	can	find	40	awesome	free	Lightroom	downloads	to	make	black	and	white	photos	in	Photoshop	here:	40	Free	B&W	Presets	for	Lightroom	—	Convert	Photos	to
Monochrome	Explore	More	Photoshop	Tutorials	and	Resources	It's	worth	taking	the	time	to	experiment	with	these	different	methods	when	deciding	how	to	approach	using	Photoshop	to	make	an	image	black	and	white.	Some	may	work	better	for	you	than	others,	but	always	remember	to	keep	an	original	copy	of	the	image	if	using	a	destructive	method,
and	ultimately	it's	always	better	to	work	non-destructively,	so	you	have	the	option	to	change	your	mind.	There	are	a	number	of	ways	to	convert	an	image	to	black	&	white	in	Photoshop;	this	post	explains	how	to	do	it	using	an	adjustment,	which	can	be	applied	via	either	a	smart	filter	or	an	adjustment	layer.	Both	smart	filters	and	adjustment	layers	apply
changes	to	the	color	and/or	tone	of	your	image,	but	they’re	layered	on	top	of	your	image	–	not	made	to	the	image	itself.	This	means	you	can	modify	them,	or	turn	them	on	or	off,	without	changing	the	original	image.	Smart	filters	apply	to	a	single	image,	whereas	an	adjustment	layer	applies	to	all	layers	that	come	after	it	(not	just	image	layers).	Here’s
an	example	showing	an	image	before	and	after	the	black	&	white	adjustment	was	applied.	In	this	case,	the	adjustment	was	only	applied	to	the	background	image.	Prerequisites	You	have	an	existing	.psd	file.	The	image	you	are	working	with	is	a	smart	object.	Convert	a	single	image	to	black	and	white	using	a	smart	filter	Select	the	image	in	the	Layers
panel.	Click	Image	>	Adjustments	>	Black	&	White.					The	Black	and	White	adjustment	presets	will	be	displayed.	You	can	adjust	the	color	values	if	the	defaults	aren’t	exactly	what	you	want.					Click	OK.	A	new	smart	filter	will	appear	underneath	your	image	in	the	Layers	panel.					Create	an	adjustment	layer	to	change	all	subsequent	layers	to	black	and
white	In	the	Layers	panel,	select	the	image	you	want	to	convert	to	black	and	white.	In	the	Adjustments	panel,	click	the	Black	&	White	icon.					The	Black	and	White	adjustment	presets	will	be	displayed.	You	can	adjust	the	color	values	if	the	defaults	aren’t	exactly	what	you	want.					References	Photoshop	version	The	version	of	Photoshop	used	for	this
post	was	the	2017.1.1	Release	of	Adobe	Photoshop	CC,	20170425.r.252	x64,	on	OS	X	10.13.1.


